Formatting Dissertations or Theses for UMass Amherst with Word 2007, 2010 or 2013

Getting started – make your life easy (or easier at least)

1. Read the Graduate School’s **Guidelines** and follow their rules.
2. Choose some basic formats, then use them for everything:
   a. a common 10 to 12 point True Type font (Calibri 11, the default font, is acceptable; or the former default font, Times New Roman)
      Note: do not use the default paragraph spacing in Word 2010 or 2013.
   b. margins: 1.5 inches on the left, 1 inch each for top, bottom and right.
      Note: do not use the default margins in Word 2007, 2010 or 2013.
   c. paragraphs for chapters: double-spaced, first line indented 0.5 inch, widow and orphan protection on, no hyphenations; left-justified or full-justified.
   d. block quotes: indent the left margin of your paragraph; use single space.
3. Use the Spelling checker – put technical words for your discipline in its dictionary.
4. Make sure all tables and figures fit within the required margins. If some don’t, you will have to rotate them or place them on landscape-oriented pages. If you can, keep landscape pages together, preferably at the end, rather than switching back and forth between landscape and portrait.
5. Some things to avoid:
   a. Do not attempt to put dots in a list by pressing the period key repeatedly. Set a tab stop (Paragraph dialog box launcher > Tabs). and under Leader choose #2, dots.
   b. Do not attempt to line things up by pressing the tab key repeatedly. Set a tab stop where you want it.
6. Use styles to make your headings within chapters consistent (see section IV in this document).
7. Bibliography: single-spaced with a blank line between entries. Word can keep each entry on the same page, as required.
8. Don’t type your Table of Contents yourself – let Word do it. If you use the Heading styles in your document, Word can create a Table of Contents for you.
I. the template files

There are two different template files in order to meet the needs of different graduate students. The Graduate School permits three different formats of headings and Table of Contents entries. This handout includes, and the templates support, the two most commonly used formats. I call those formats the “simple” and the “numeric” formats.

Select the template that uses the styles of Headings and Table of Contents that you prefer to use. You can change your mind later.

The templates are the same for Word 2007, 2010 and 2013.

A. in the IT Computer Classrooms

If you are working in the IT Computer Classrooms, the templates are in the UMass Thesis Templates folder under Public Documents:
B. on your own computer: save the templates files in your Templates or Custom Office Templates folder

Windows 7 and 8

Open the Thesis CD or download the two templates to your desktop. The image below shows a view of the files on one of the CDs:

Open one of the template files. It will appear to be blank – it has no text in it, just style definitions.

Under the Microsoft Office button (2007) or File (2010 or 2013), choose Save As.

Word 2007 & 2010

In Word 2007 and 2010, Word will open the folder for templates. Save the file as a template (the extension will be .dotx). Repeat with the other template file. This image shows the Word 2010 Templates folder with one of the thesis templates saved in it and the other ready to save.
**Word 2013**

In Word 2013, browse to the Custom Office Templates folder (inside the Documents folder). This image shows the Custom Office Templates folder with both templates saved in it.

![Custom Office Templates folder](image)

---

**Word 2007 and older versions of Windows**

In older versions of Windows, you should save the files to the *My Templates* folder. The My Templates folder has a path to it that will look similar to this (with your name instead of “your-name”):

* C:\Documents and Settings\your-name\Application Data\Microsoft\Templates

**first, find the Templates folder**

Start Word and open a file. Click the *Microsoft Office Button*; at the bottom of the screen, click *Word Options*:

![Word Options](image)
On the Word Options drop-down menu, click on **Add-Ins**: 

At the bottom of the “View and manage Microsoft Office add-ins” dialog box, on the **Manage** pane, select **Word Add-ins** then click **Go**:

Word brings up the Templates and Add-ins dialog box. Next to the Document template pane, where it says Normal, click the **Attach** button:
Word displays the Templates folder. To the right of the pane with the word Templates, hold your cursor down on the downward pointing triangle; Word will display the path to the Templates folder. Make some notes so you can remember the path!

**make the Application Data (or AppData) folder visible**

The Application Data (or AppData) folder, by default, is “hidden” and you can’t open it. To make it visible:

1. In the **Start** gallery, choose **Control Panel**.
2. In one version of Windows 7:
   a. In the Control Panel, choose **Folder Options**
   b. In Folder Options, choose the **View** tab
   c. Click on **Show hidden files and folders**
3. In a newer version of Windows 7:
   a. In the Control Panel, choose **Appearance and Personalization**
   b. In Appearance and Personalization, under Folder Options choose **Show hidden files and folders**
   c. Click on **Show hidden files and folders**
C. starting a document and using the UMass template

Windows 7 or 8 with Word 2013 on your own computer

Start Word, or, within Word, select New. Word opens a screen where you can select a set of templates; if you saved the dissertation templates as described, they will be under the PERSONAL tab:

![PERSONAL templates](image)

Select umass07simple or umass07numeric by clicking on it and then clicking OK.

Windows 7 or 8 with Word 2007 or 2010 on your own computer

Start Word, or, within Word, select New. Word opens a screen where you can select a set of templates; if you saved the dissertation templates as described, they will be under My Templates:

![My Templates](image)

Select umass07simple or umass07numeric by clicking on it and then clicking OK.
**older versions of Windows**

Start Word, or, within Word, select **New**. Word opens a screen where you can select a set of templates; select **My templates**.

![Selecting templates in Word](image)

Word displays the templates in the My Templates folder:

![My Templates folder](image)

Select **umass07simple** or **umass07numeric** by clicking on it and then clicking **OK**.

**in the IT Computer Classrooms (Windows 7 and Word 2013)**

First open a Blank Document then follow the steps for “applying the template to an existing document” with Windows 7 & 8, Word 2013.
D. applying the UMass template to an existing document

Windows 7 & 8

With the document open, go to **File**; choose **Options**, which is near the bottom. The first image here is from Word 2010, the second is from Word 2013 (color inverted to make it easier to read).

On the **Word Options** screen, in the left panel, choose **Add-Ins**. At the bottom of the dialog box, in the **Manage** pane, select **Templates** then click **Go...**
**Word 2007 & 2010**

In Word 2007 and 2010, Word displays the Templates folder; click on the one you want (umass07numeric or umass07simple) and then click **Open**:

![Template selection in Word 2007 and 2010](image)

**Word 2013 (in Windows 7 or 8)**

Word brings you to the **Templates and Add-ins** dialog box:

![Template and Add-ins dialog in Word 2013](image)

Click the **Attach** button.
Word opens the **Templates** folder. In the panel on the left, click on **Documents**.

In the Document dialog box, open **Custom Office Templates**.
Word brings up the Custom Office Templates dialog box. Click on the one you want, then click **Open**.

![Custom Office Templates dialog box](image1.png)

**all versions of Word**

After you click **Open**, Word presents you with the Templates and Add-Ins screen. Be sure to click for **Automatically update document styles**. Then click **OK**.

![Templates and Add-ins](image2.png)
older versions of Windows

With the document open, follow the steps we took in “first, find the Templates folder” earlier in this handout. Once you get to the display of templates, click on the one you want (umass07numeric or umass07simple) and then click Open:

Word returns to the Templates and Add-ins dialog box. Be sure to click for Automatically update document styles. Then click OK.
II. general formatting of chapters

A. the font and style we use in UMass templates

We use Calibri, 11 point, Microsoft Word’s default font, as our default style (which is called Normal):

The Normal style is also single-spaced, left justified, turns on Widow/Orphan Control and turns off Hyphenation.

**NOTE for users of Word 2010 and 2013**

The Normal Style defined by Microsoft for these versions of Word uses an odd spacing between lines (1.15 or 1.08 instead of 1) and adds extra space between paragraphs (10 or 8 points, respectively). Neither of these is acceptable to the Graduate School. If you do not use the UMass template, you must modify the spacing for the Normal style yourself. See the next sections of this handout on “styles” for how to modify a style.

**NOTE on the relationship between the font in Normal style and other styles:**

If you change the Normal font to something else, you must check and may need to change the other styles you use as well – headings, caption, page number, endnote or footnote and their references, etc.

**how styles are defined**

You can see which styles are used and what they are called by looking on the Home ribbon; to see all of the style names at once, click on the “styles dialog box launcher” in the Styles group (the downward-pointing arrow to the right of the word “Styles”).
to modify a style

In the list of styles as shown above, select the style you want to change; click on the little arrow pointing down (or right-click); o, on the Home ribbon, in the Styles group, right-click on the style you want to modify (in this case, Normal); Word brings up a screen listing choices, choose Modify.

Word then displays a screen where you can modify the **Font** or the **Format** of the style. Format includes tab setting and paragraph characteristics, as well as other things we don’t use in theses.
Word 2013

In Word 2013, you can change the spacing of the Normal style another way: on the Design ribbon, in the Document Formatting group, select Paragraph Spacing.

From the choices Word offers, select No Paragraph Space which will make the Normal style actual single space – spacing of 1, with no extra space before or after a paragraph. Then choose Set as Default

B. the Page Layout

On the Page Layout ribbon, Page Setup group, choose Margins:

At Margins, hold your cursor down on the arrow; when the Margins dialog box opens, move your cursor to the bottom to Custom Margins:
On the **Page Setup** dialog box, the margins should be 1 inch on the top, right and bottom and 1.5 inches on the left.

Be sure that **Apply To:** is set to **Whole Document**. Or that you set these margins in all sections of your document (except for Landscape-oriented pages).

### C. page numbering

Set the page numbering: on the **Insert** ribbon, in the **Header & Footer** group; click **Page Number**; choose **Bottom of Page** and then choose **Plain Number 2**.

Page numbering is at bottom center (in the footer). It is supposed to be 0.5 inch from the bottom of the page and about that from the last line of text. Word usually inserts an extra blank line under the page number, which moves the number up too high in the margin. Check for that extra blank line (you will need to have “Show hidden characters” turned on to see it) and, if it exists, select the paragraph mark and delete it.
Return to the **Page Number** menu and select **Format Page Numbers**.

On the Page Number Format dialog box, set the **Number Format** to Arabic (1,2,3, etc). Within the first chapter, select **Start at 1**.

In all subsequent chapters, use **Continue from previous section**.

**Two things to look out for:**

1. **Word 2010 and 2013 often put an extra blank line in the footer** below the page number; remove the line or the page number will not be in the right place.

2. **The font for page numbers is not based on the Normal style.** If you change the Normal style, change the Page Number style as well.

If you have pages in landscape orientation, see the section on *adding a portrait page number* later in this document.

**D. adding words to the dictionary**

The Spelling and Grammar checker can find typing mistakes for you. But you need to add the technical terms for your discipline or Word will mark those too, even if they are correctly typed.

On the **Review** ribbon, in the **Proofing** group, select **Spelling and Grammar**. When the program finds a word it does not recognize, it opens a dialog box with suggestions and several options; if you are sure the word is correct, choose **Add to Dictionary**.
E. the format for paragraphs in the text

Within the chapters, most of the text is double-spaced, either left-justified or fully justified, no hyphenation, and with an indent on each first line. Either use the style I created for paragraphs (called **paragraph-chapters**) or set the paragraph format yourself. In Word 2013, if you set Normal to be No Paragraph Space, you can select 2 in the paragraph-spacing icon and it will work well (without an indent). In Word 2010 or 2013, if you have not changed the Normal style to remove the extra space after paragraphs, you need to change that as well as the overall spacing.

**To use the paragraph-chapters style:**
Type a paragraph for the text, without any formatting. Then select that paragraph by clicking your cursor in it once. On the **Home** ribbon, **Styles dialog box launcher,** in the gallery, click on the name **paragraph-chapters.**

To set a paragraph format yourself in the **Paragraph dialog box:**
On **Home ribbon Paragraph group,** **Paragraph dialog box launcher,** **Paragraph dialog box:** on the **Indents and Spacing** tab, select **double space**; under **Special,** select **First Line indent 0.5 inch.**
F. using the header to put chapter number and date of printing on each page (optional)

We can use Word to help us keep track of our document as we work on it so we aren’t buried in indistinguishable stacks of paper. Word can print information on each page in the header or footer; I chose header here since the footer is being used for the page numbers.

On the Insert ribbon, Header & Footer group, click on Header.

Word brings up a menu of built-in choices; choose the first one, Blank. In the space provided, type an abbreviation for the chapter (like C1 for Chapter 1) then a space or two, then a dash, then a space or two. You might want to include your name in case your advisor has many theses to read at the same time. Then click on the icon for Date & Time and choose the format you want from the list provided. For example:

Word will print the text you typed and the date (and time, if selected) on each page every time you print this chapter. That way, any piece of paper you pick up will tell you what chapter it is from, its page number within that chapter (bottom of page) and the date (and time) you printed it, so you know if this is the most recent version of the chapter or an older page you can recycle.
III. references

The Graduate School allows: (1) citations in the text; (2) footnotes at the bottoms of pages; (3) endnotes at the end of the entire document; (4) or endnotes at the end of each chapter. If you must have notes, putting notes at the end of each chapter is easiest for the writer. However, if you have any pages in landscape orientation (wider than they are tall), Word cannot automatically put the notes at the end of individual chapters or at the end of the dissertation (before the Bibliography) because the Section Break for the landscape page(s) causes Word to put the endnotes there. You can use footnotes that are numbered sequentially throughout the document.

A. citations in the text

Word’s “citation” feature: on the References ribbon, Citations & Bibliography group, in Style: choose a style of citation from among those offered by Word.

Once you have chosen the style, click on the Insert Citation button.

Word opens a gallery in which you choose whether to enter a placeholder or bibliographical information.

If you choose to enter a placeholder, you can come back later and fill in the bibliographical information. If you choose to enter the information now, Word opens a dialog box in which you enter the bibliographical information.
Word inserts the citation in the text of the chapter: The citation includes author and date, but not page number.

philosophy), is what truly exists. In this framework, a "species" is an actual entity, of which the members are merely representatives. (Alec 2010)

B. footnotes or endnotes

If the “citations” form does not work for you, create footnotes or endnotes. On the References ribbon, Footnotes group, select the Footnotes dialog box launcher. Word opens the Footnote and Endnote dialog box. Choose Footnotes. Or Endnotes at: End of section.

For either footnotes or endnotes, choose Arabic numbers (1, 2, 3, etc.), Start At 1, and, usually, Numbering: Restart each section.

If you want endnotes at the end of the document, or footnotes numbered continuously through the whole document, choose Continuous.

For Apply changes to:, select Whole document:

Click on the Apply button.

Word puts a super-scripted reference number in the text (which it updates as necessary) and opens an endnote/footnote window in which it also puts the reference number and waits for you to type the actual text of the note.
You will need to format the note to follow the style in your Style Manual. Word 2007/2010/2013 provides many of the most frequently-used reference styles. You may be able to use the citation command to format your footnote or endnote.

Also, don’t forget to check the font for these references and their reference numbers if you are not using the default font from one of the UMass templates.

If you want footnotes to begin numbering with 1 in each chapter, or, if you want endnotes at the end of each chapter, you must separate chapters with a Section Break > Next Page.

**endnote placement**
There are two choices for placing endnotes: at the ends of each chapter or at the end of the thesis or dissertation (just before the Bibliography).

Word puts the notes at the end of the current section. To put notes at the ends of chapters, end each chapter with a Section Break. Insert a Page Break at the end of the text in the chapter (before the Section Break) so that notes begin printing on a new page, not on the last page of text. Then replace the default “note separator” (see below).

To put notes at the end of the thesis or dissertation, insert a Page Break between each chapter, and insert a Section Break before the Bibliography.

**note separators**
To change the “separators” (which separate the notes from the chapter’s text) from the default: In View > Draft, go to References > Footnotes > Show Notes. Go to the note “pane,” by clicking on the arrow next to the phrase All Endnotes. Select Endnote Separator; within that window, remove the line that is there by default, then type the word Notes, center and bold it, and add a blank line:

Next, select Endnote Continuation Separator from the pane and replace the line that was in it with a space, and press the Return key twice. This will cause these pages to print without a visible separation (instead of a line across the page, which is the default).
C. bibliography

The format of your Bibliography is determined by the Style Manual you are using (see “Appendix G: Suggested Style Manuals,” in the Graduate School’s Guidelines).

using Word’s citation feature

Word 2007/2010/2013 has built-in styles for many of the most-frequently used bibliography styles, which can create an alphabetized list from the information in citations. If you used citations for references, you can use that to build the bibliography.

In the References ribbon, Citations and Bibliography group, select the Style and Bibliography. From the drop-down menu, select Bibliography:

![Word's Bibliography feature]

Word inserts a bibliography based on the citations you have entered and format for the style you selected. Note that the title is upper-lower case, and it is not in the Heading 1 style; the Graduate School requires it to be capitalized. If you will use Word to create your Table of Contents, the title must also be in the Heading 1 style.

Select the entries and change the paragraph style to make sure that entries are single-spaced, have a blank line between each one and do not break across pages (see the examples on the next page).

typing the Bibliography

If you are typing the entries yourself, use the style Bibliography and/or make the paragraphs single-spaced with “Keep lines together” turned on. Check your style manual for whether you need the hanging indent.
**paragraph formatting**

The **Bibliography** style uses single spacing.

If your style requires a hanging indent so only the first line of each entry starts at the left margin and all subsequent lines are indented, on the **Indents and Spacing** tab, under **Special**, choose **Hanging** and the amount (usually 0.5 inch).

To keep the text of each entry on one page, on the **Line and Page Breaks** tab, click to put a check next to **Keep Lines Together**.
D. back up your bibliography source file / citations list

The bibliography source file is kept in a separate file from your document(s). It can be used by any document on the same computer. Back up your bibliography source file so it will not be lost in case of computer problems or theft.

First, if you have not already done so, set Windows to show Hidden Folders as shown on page 7 of this handout.

Next, find the bibliography source:
Starting from the main drive (usually C:) click down thru the directories to the folder where Microsoft stores the file. On most computers the path looks like this:
Users > name > AppData > Roaming / Microsoft > Bibliography
the file is called Sources.XML (it is not a .DOCX document)

If your AppData folder is not visible under your name under User, it could be because you didn’t set Windows to show hidden folders (this is the hidden folder you need). Or in your installation, it could have been put somewhere else. To find it –
Press the Windows key on your keyboard (usually between the Ctrl and Alt keys)
On the screen that appears, type
echo %appdata%
and press Enter.

Once you have found the file, copy it to a backup device as frequently as you add information to it that you do not want to lose.
IV. headings and captions

A. headings in chapters

The Graduate School requires that each chapter have a title. Most people also have at least one level of headings within the chapters. The Guidelines show three different formats of headings and their corresponding entries in the Table of Contents. This handout includes the two most commonly used ones: the simple format and the numeric format. The simple format is recommended whenever possible. The numeric format is often used in the sciences.

The **Heading 1 - Heading 5** styles in the UMass templates will format the headings correctly in your chapters and mark the headings for proper inclusion in your Table of Contents.

**Heading 1** is used for the acknowledgements, abstract, chapter titles, bibliography, and any appendices. Note that if you are using bold face for your chapter titles, you need to also bold face the word CHAPTER and its number. You need to do that yourself, since those paragraphs are not in Heading 1 style. Type all Heading 1 titles in all capital letters so they will appear in the Table of Contents in all caps.

For Heading 1, the style is the same for both the simple format (from the *umass07simple* template) and for the numeric format (from the *umass07numeric* template).

**Heading 2** is for the first level of subheadings. For the simple format, Heading 2 is centered, upper/lower case, underlined; because Heading 1 is in bold, so is Heading 2. For the numeric format the heading is bold and at the margin, preceded by a number (e.g., 1.1 Introduction is the first Heading 2 in Chapter 1).

**Heading 3** is for the second level of subheadings. For the simple format, Heading 3 is centered, upper/lower case, **not** underlined; because Heading 1 is in bold, so is Heading 3. For the numeric format, the heading is bold and at the margin preceded by a number (e.g., 1.1.1 is the first Heading 3 in Chapter 1, section 1).

**Heading 4** is for the third level of subheadings. For the simple format, Heading 4 is at the margin, upper/lower case, underlined; because Heading 1 is in bold, so is Heading 4. Numeric format is bold; example: 1.1.1.1.

**Heading 5** is for the third level of subheadings. For the simple format, Heading 5 is at the margin, upper/lower case, **not** underlined; because Heading 1 is in bold, so is Heading 5. Numeric format is bold; example: 1.1.1.1.
B. captions for tables and figures

The Graduate School permits you to number the captions sequentially throughout the document (Table 1, Table 2, etc.) or to number them with the chapter number included (Table 1.1, Table 1.2, etc.). It is easier to use the simple format if you are able to put all Tables and Figures in Appendices at the end of the thesis or dissertation.

You may be able to use Word’s Insert Caption command; however, I have found it difficult because we have to make changes in the captions that Word inserts and Word often attempts to “correct” our changes. If you want to try it: on the References ribbon, Captions group, click Insert Caption. Do not use auto-caption (because we don’t have the chapter numbers in the style Heading 1).

If a table or figure cannot fit on the current page, but will fit on one page, insert a Page Break to put the entire object on one page (i.e., don’t split a table or figure unless you have to).

Generally, captions for figures go below the figure; captions for tables go above the table.
V. finishing

A. adding a portrait page number to a landscape page

If you have landscape-oriented pages (pages wider than they are tall) you have to put portrait-oriented page numbers on them. It may be possible to put the table or figure on the page in portrait orientation and then rotate the object; that’s the easiest method. If that doesn’t work, make a section for the landscape page(s).

*insert Section Breaks*

1. At the end of the page of text (the portrait page), on the *Page Layout* ribbon, *Page Setup* group, select *Breaks*, then select *Section Breaks / Next Page*. Insert a *Section Breaks / Next Page* after the landscape page (or pages) and before the next portrait page.

2. In *View > Print Layout* with the insertion point in each *Section in turn*, under the *Insert* ribbon, *Header & Footer* group, click *Header*. If you do not yet have a Header in that section, choose the *Blank* header. If you already have a Header, choose *Edit Header*.

3. Under the *Header & Footer Tools* ribbon, if *Link to Previous* has an orange (Word 2007-2010) or blue (Word 2013) box around it, click on it to break the “*Same as Previous*” link between headers. Repeat for Headers and Footers in the landscape section and the portrait section after it. The example shows the document *before* you click to break the link.
put in the page numbers

1. In the **Insert** menu, select **Page Number** and from the options presented, select **Page Margins**; then choose **Vertical, Left**.

2. Word inserts the word Page and the page number in the left margin, near the bottom. That is not acceptable, so we have to modify it. First, click on the text to select it as a text block.

3. Above the ribbon, select **Text Box Tools** (Word 2007) or **Drawing Tools** (Word 2010-2013). On the new ribbon, in the **Text** group, find the icon for changing the orientation of the text and click on it until the page number in the text block is tipped so the top of the number is near the text on the page.
4. Highlight the word Page and delete it. Highlight the number and paragraph mark (it looks like a backward capital P) and change its font to the font you are using as your Normal font (if you are following the template, it’s Calibri 11 point). To change the font, go to the Home ribbon, and find the Font section.

5. To put the number in the correct position on the page (the middle, vertically, and half an inch from the left edge):
   
   a. On the Home ribbon, in the Paragraph group, center the “paragraph” that is inside the Text Box

   b. In the Text Box Tools (or Drawing Tools) ribbon, under Format, select Position. From the options presented, select More Layout Options (at the bottom):
6. Word presents a screen on which you enter information to tell it where to put the text box. You will have to check to be sure the number ends up in the same place as it is on the portrait-oriented pages.

If that doesn’t get the number in the right place, try:
- **Horizontal**: Absolute position 0.5 inch to the right of Page
- **Vertical**: Absolute position 4.4 inches below Page (from the top of the page).

### B. put chapters into the same file as preliminary pages

Put all the chapters together by copying them, in turn, and pasting them into the end of the file with the preliminary pages in it (*prelim07simple* or *prelim07numeric*).

Substitute your name, committee members’ names, dates, etc. for the place holders. If you do not have a Dedication, Acknowledgements, or lists of Figures or Tables, delete those pages (but keep the Section Breaks between Dedication and Acknowledgements and at the end). Then copy the files containing your chapters into the file with the preliminary pages, after the **Section Break**. If you do not have a Dedication or Acknowledgements, you may need to change the number for the first numbered page (see the next page of this handout for how to change that page number).

Make sure that **Same as Previous** is turned off for the **Footer** in both the preliminary pages and the first chapter.

If you do not have endnotes at the ends of chapters, or renumber footnotes in each chapter, that start again at 1, insert a page break between each chapter.
If you have endnotes at the ends of chapters or renumber footnotes in each chapter

If you have endnotes at the ends of chapters, be sure you have done a Page Break after the text in each chapter (so that the notes begin on a new page, not at the bottom of the last page of text). On the Insert ribbon, Pages group, click on Page Break:

For renumbering footnotes or to put endnotes at the ends of chapters, insert a Section Break: on the Page Layout ribbon, Page Setup group, in Breaks, choose Section Breaks Next Page at the end of each chapter (so that the next chapter begins on a new page).

C. preliminary pages

The best option is to use the actual file on the disk (prelim07simple or prelim07numeric) and substitute your name, committee members’ names, dates, etc. for the phony ones we used in the example. If you are not using one of the Prelim files, be sure to use the same font, orientation and margins as in the main part of the document. Then follow the instructions below to put in the page numbers.

Page numbers

Page numbering first appears on the Acknowledgments page (if there is no Acknowledgments page, it appears on the Abstract page); it begins with the number of the actual piece of paper (page 5 if you have both a Dedication and Acknowledgments – as in the sample dissertation). If you are not using either prelim07 file, insert a Section Break between this page and the previous page.

Make sure that Same as Previous is turned off for the Footer.

On the first page that gets a printed page number, turn on page numbering on the Insert ribbon, Header & Footer group, Page Number (see earlier in this handout about how to turn on page numbering if you don’t remember).
Go back to **Insert > Header & Footer > Page Number**; this time, select **Format Page Numbers**:

On the Page Number Format dialog box, set the **Number format** to lower-case Roman numerals and set **Page Numbering** either to **Continue from Previous Section** or to **Start At**: the appropriate number (in our example, \textit{v}).

When you paste your chapters into the document after the preliminary pages, make sure that:

1. there is a Section Break / Next Page between the preliminary pages and the first chapter (if you use one of the Prelim07 files, the Section Break is there, at the end).
2. **Same as Previous** is turned **off** for the **Footer**.

**D. create lists of tables and figures**

Once all the chapters are together in one file, you can create the lists of Tables and Figures. Click your cursor in the area of the file where you want your list of Tables or Figures. Then, on the **References** ribbon, **Captions** group, click on **Insert Table of Figures**:
Word brings up a dialog box where you can choose whether to create a Table of Figures or of Tables, based on the Caption label. Select appropriately (our example is for Tables).

Word usually creates a list but it isn’t quite right. [I say “usually” because sometimes this function doesn’t work at all. In that case, you have to type your lists of Figures and Tables yourself.]

For the numeric version, where captions for all figures (and tables) include the chapter number, it looks like this:

LIST OF FIGURES

<table>
<thead>
<tr>
<th>Figure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1.1: Caption for my First Figure</td>
<td>4</td>
</tr>
<tr>
<td>Figure 2.1: Caption for my Second Figure</td>
<td>8</td>
</tr>
</tbody>
</table>

The simple version looks similar except for the numbering.
We need to fix the list by changing the text to “regular” (not bold), removing the word “Figure” in front of each number, changing the colon to a period, and changing the space after the colon to a tab. For the simple list, it should look like this:

```
<table>
<thead>
<tr>
<th>Figure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>Caption for my First Figure</td>
</tr>
<tr>
<td>2.1</td>
<td>Caption for my Second Figure</td>
</tr>
</tbody>
</table>
```

For a more detailed discussion about editing lists created by Word, see the discussion about Table of Contents later in this handout.

If, later on, you need to update the page numbers in this list without changing the words or their formatting, you can do that on the References ribbon, Captions group, by clicking on Update Table.

**E. create the table of contents**

Once all the chapters are together in one file, and you have created your List of Tables and/or List of Figures (if needed): click in the dummy Table of Contents; then, on the References ribbon, Table of Contents group, click on Table of Contents:
Choose **Insert Table of Contents** (Word 2007 & 2010) or **Custom Table of Contents** (Word 2013) to get to the dialog box where you can tell Word how many levels to include in your Table of Contents.

![Table of Contents Example](image)

You have to do some reformatting.
Insert Table of Contents presents the dialog box where you can choose the number of levels. **Remove the check** next to Use hyperlinks instead of page numbers – it reduces the headaches of formatting the table of contents correctly later. Be sure there are checks for **Show page numbers** and **Right Align page numbers**; the Tab **leader** box should show dots, the Formats should be **From template**.

When Word asks if you want to replace the selected Table of Contents, click on **OK**.

Word creates a Table of Contents with the correct order, page numbers and general formatting; see the examples on the next page.
fix the table of contents

For either Table of Contents, you need to do some reformatting (see the Graduate School’s Guidelines and/or my example dissertation):

- the preliminary material (Acknowledgements, Abstract, List of Tables, etc.) are double-spaced
- contiguous headings of the same level should be single-spaced in relation to each other; headings of different levels should be double-spaced in relation to each other
- add the word CHAPTER above the first chapter name
- add the numbers of chapters (Arabic or Roman, as in chapters) and tab the name to 0.5 inches
- if you have one Appendix, list it like a chapter title (double-spaced at margin) but without a number or letter; if you have two or more Appendices, put the title APPENDICES above them, double-spaced (like the word CHAPTER) then list the appendices in single space, with a letter instead of a number for each one.

You can click in the Table of Contents and edit it. Be careful to stay away from the page numbers so Word won’t jump to that page in the document (especially if you forgot to turn off the hyperlinks). I recommend you move your cursor as far to the left as possible on a line of text (for example, next to the word New in the title of the first chapter); the cursor image should change to an I-bar (it looks like a capital I) instead of an arrow or hand. Then click. Once you have the cursor in the ToC, it is generally easier to move around using the arrow keys on your keyboard – that way you won’t give Word an excuse to jump to a page in the document.

When you are inserting new lines for text, or making a double-space between two lines, pay attention to whether the Line Spacing in the “paragraph” is set for Double or Single space. Usually it should be Single space (a blank single-spaced line between two lines with text makes them look double-spaced). You can check the spacing by going to the Home ribbon, Paragraph group, Line spacing command / icon (right above the “graph” of Paragraph).

Make sure the titles don’t obscure the page numbers; if a title is long, insert a line break: click before a word an inch or more to the left of the page number, hold down the Shift key on your keyboard, and press Enter.

Examples of Tables of Contents are on the next two pages.

updating page numbers

If, later on, you need to update the page numbers in the ToC without changing the words or their formatting, on the References ribbon, Table of Contents group, click Update Table; choose Update page numbers only.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACKNOWLEDGMENTS</td>
<td>v</td>
</tr>
<tr>
<td>ABSTRACT</td>
<td>vi</td>
</tr>
<tr>
<td>LIST OF TABLES</td>
<td>viii</td>
</tr>
<tr>
<td>LIST OF FIGURES</td>
<td>ix</td>
</tr>
<tr>
<td>CHAPTER</td>
<td></td>
</tr>
<tr>
<td>1. NEW SCIENTIFIC DARWINISTS</td>
<td>1</td>
</tr>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Thomas Henry Huxley</td>
<td>1</td>
</tr>
<tr>
<td>Discoveries of Organic Chemists and Evolutionists Complementary</td>
<td>2</td>
</tr>
<tr>
<td>Applicability of Darwin's Argument to Human Beings</td>
<td>2</td>
</tr>
<tr>
<td>An Example of a Heading 4 Subdivision Head</td>
<td>3</td>
</tr>
<tr>
<td>An Example of a Heading 5 Subdivision Head</td>
<td>3</td>
</tr>
<tr>
<td>2. SECOND CHAPTER TITLE</td>
<td>5</td>
</tr>
<tr>
<td>Ernst Heinrich Haeckel</td>
<td>5</td>
</tr>
<tr>
<td>Haeckel’s Anti-Anthropocentrism</td>
<td>5</td>
</tr>
<tr>
<td>APPENDICES</td>
<td></td>
</tr>
<tr>
<td>A. THE DARWINIAN REVOLUTION</td>
<td>8</td>
</tr>
<tr>
<td>B. THE TABLES</td>
<td>9</td>
</tr>
<tr>
<td>BIBLIOGRAPHY</td>
<td>10</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACKNOWLEDGMENTS</td>
<td>v</td>
</tr>
<tr>
<td>ABSTRACT</td>
<td>vi</td>
</tr>
<tr>
<td>LIST OF TABLES</td>
<td>viii</td>
</tr>
<tr>
<td>LIST OF FIGURES</td>
<td>ix</td>
</tr>
<tr>
<td><strong>CHAPTER</strong></td>
<td></td>
</tr>
<tr>
<td>1. NEW SCIENTIFIC DARWINISTS</td>
<td>1</td>
</tr>
<tr>
<td>1.1 Introduction</td>
<td>1</td>
</tr>
<tr>
<td>1.2 Thomas Henry Huxley</td>
<td>1</td>
</tr>
<tr>
<td>1.2.1 Discoveries of Organic Chemists and Evolutionists Complementary</td>
<td>2</td>
</tr>
<tr>
<td>1.2.2.1 An Example of a Heading 4 Subdivision Head</td>
<td>3</td>
</tr>
<tr>
<td>1.2.2.1.1 An Example of a Heading 5 Subdivision Head</td>
<td>4</td>
</tr>
<tr>
<td>2. SECOND CHAPTER TITLE</td>
<td>6</td>
</tr>
<tr>
<td>2.1 Ernst Heinrich Haeckel</td>
<td>6</td>
</tr>
<tr>
<td>2.1.1 Haeckel's Anti-Anthropocentrism</td>
<td>7</td>
</tr>
<tr>
<td><strong>APPENDICES</strong></td>
<td></td>
</tr>
<tr>
<td>A. THE DARWINIAN REVOLUTION</td>
<td>9</td>
</tr>
<tr>
<td>B. THE TABLES</td>
<td>10</td>
</tr>
<tr>
<td>BIBLIOGRAPHY</td>
<td>11</td>
</tr>
</tbody>
</table>
Appendix: styles

A. heading styles

**Heading 1** is for the Abstract, Chapter Titles, Bibliography, any Appendices, etc. Note that if you are using bold face for your chapter titles, you need to also bold face the word CHAPTER and its number. You need to do that yourself, since those paragraphs are not in Heading 1 style. For Heading 1, the style is the same for both the simple format (from the *umass07simple* template) and for the numeric format (from the *umass07numeric* template).

<table>
<thead>
<tr>
<th>ABSTRACT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font: Bold, Centered, Line spacing: Double, Keep with next, Keep lines together, Don't hyphenate, Level 1, Style: Linked, Quick Style, Priority: 10, Based on: Normal, Following style: Normal</td>
</tr>
</tbody>
</table>

**Heading 2 is for the first level of subheadings.**

the simple Heading format: from umass07simple.dotx

<table>
<thead>
<tr>
<th>Introduction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font: Bold, Underline, Centered, Line spacing: Double, Keep with next, Keep lines together, Don't hyphenate, Level 2, Style: Linked, Hide until used, Quick Style, Priority: 10, Based on: Normal, Following style: Normal</td>
</tr>
</tbody>
</table>

the numeric Heading format: from umass07numeric.dotx

<table>
<thead>
<tr>
<th>1.1·Introduction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font: Bold, Indent: Left: 0&quot;, Hanging: 0.5&quot;, Space Before: 21 pt, After: 14 pt, Keep with next, Keep lines together, Don't hyphenate, Level 2, Tab stops: 0.5&quot;, Left, Style: Linked, Hide until used, Quick Style, Priority: 10, Based on: Normal, Following style: Normal</td>
</tr>
</tbody>
</table>

**Heading 3 is for the second level of subheadings.**

the simple Heading format: from umass07simple.dotx

<table>
<thead>
<tr>
<th>Discoveries·of·Organic·Chemists·and·Evolutionists·Complementary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font: Bold, Centered, Line spacing: Double, Keep with next, Keep lines together, Don't hyphenate, Level 3, Style: Linked, Hide until used, Quick Style, Priority: 10, Based on: Normal, Following style: Normal</td>
</tr>
</tbody>
</table>
Heading 4 is for the third level of subheadings.

Heading 5 is for the fourth level of subheadings.

B. styles for Table of Contents

Word automatically uses styles TOC1-TOC5 to format the ToC entries.

For all TOC styles, the Tab stop position for the page number is a Right tab to 6 (for 6 inches) (which coincides with right margin) with leading dots. To get to this dialog box: on either the Home ribbon
or the Page Layout ribbon, in the Paragraph group, click the Paragraph Dialog box launcher (the little arrow to the right of the word Paragraph). Once in the Paragraph Dialog box, click Tabs to get to the Tabs dialog box. It looks like this:

The TOC styles are:

TOC 1:
Paragraph
   Indentation: Left: 0", Hanging: 0.5", Right: 0.5"
   Line and Page Breaks: Don't hyphenate
   Tabs: Tab stops: 0.5", Left
   6", Right, Leader:...
   Style
      Style Hide until used, Priority: 40, Based on: Normal, Following style: Normal

TOC 2:
Paragraph
   Indentation: Left: 0.5", Hanging: 0.5", Right: 0.5"
   Line and Page Breaks: Don't hyphenate
   Tabs: Tab stops: 0.5", Left
   1", Left
   6", Right, Leader:...
   Style
      Style Hide until used, Priority: 40, Based on: Normal, Following style: Normal

TOC 3:
Paragraph
   Indentation: Left: 1", Hanging: 0.5", Right: 0.5"
   Line and Page Breaks: Don't hyphenate
   Tabs: Tab stops: 1", Left
   1.5", Left
   6", Right, Leader:...
   Style
      Style Hide until used, Priority: 40, Based on: Normal, Following style: Normal
I have defined the TOC styles to include and indent from the right to avoid obscuring the page numbers in the list. Unfortunately, in Word 2013, Microsoft no longer allows us to have a tab stop that extends beyond the paragraph indentation, so that trick no longer works. If you keep your headings short enough to fit on one line in the ToC, you don’t need to worry about this.

For all but TOC1, the paragraph formatting for the style includes a hanging indent so that if the title is too long to fit on one line, the second line won’t interfere with seeing the first line.

C. styles for lists of figures and tables

Table of Figures style is used for these lists. It has a hanging indent as well as being indented from the right margin so that long captions will wrap properly without interfering with the placement of the page numbers. For the numerical list: